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Warning—Read This First! 

All personnel involved with the installation, operation or maintenance of the 
equipment described in this manual should read and understand the 
warnings and recommendations provided below. 

Static Sensitive Devices 

This equipment contains devices that are extremely sensitive to static 
electrical charges. Therefore extreme care should be taken when handling 
them as static electricity may be present on the body and clothing. Normal 
handling precautions involve the use of anti-static protection materials and 
grounding straps for personnel. 

Radiation 

This equipment generates, uses, and can radiate radio frequency energy. 
Therefore if the equipment is not installed properly, it may cause 
interference with radio communications. The equipment has not been tested 
for compliance with the appropriate FCC rules designed to provide 
reasonable protection against such interference when operated in a 
commercial environment. Therefore when operating the equipment in a 
residential area, the user may be required to take whatever measures are 
needed and incur any expenses necessary to eliminate interference; it is the 
user's responsibility to verify that the system complies with the applicable 
FCC emission limits. 

High Voltages 

High voltages are present in the sonar head, power amplifier, topside 
processor, and deck cable. Always use caution when removing the 
electronics from these devices. 

Improper Line Voltage 

Operation with improper line voltage may cause serious damage to the 
equipment. Always ensure that the proper line voltage is used.
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Preface 

We, the employees at EdgeTech, would like to thank you for purchasing a 
4600 Swath Bathymetry and Side Scan Sonar System. At EdgeTech it is our 
policy to provide high quality, cost effective products and support services 
that meet or exceed your requirements, to deliver them on time and to 
continuously look for ways to improve them. We take pride in the products 
we manufacture and want you to be entirely satisfied with your equipment.  

The information contained in this manual provides the user with a 
description of the setup, operation, care, and maintenance of the EdgeTech 
4600 Swath Bathymetry and Side Scan Sonar System.  Although this manual 
encompasses the latest operational features of the 4600 System, some 
features of the system may be periodically upgraded. Therefore the 
information in this manual is subject to change and should be used for 
reference only. 
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Warnings, Cautions and Notes 

Where applicable, warnings, cautions and notes are provided in this manual 
as follows: 

WARNING 

Identifies a potential hazard that could cause personal injury or 
death to yourself or to others. 

CAUTION 

Identifies a potential hazard that could be damaging to 
equipment or could result in the loss of data. 

NOTE 

Note: Recommendations or general information that is particular 
to the material being presented or a referral to another part of 
this manual or to another manual. 
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Liability 

EdgeTech has made every effort to document in this manual the 4600 Swath 
Bathymetry and Side Scan Sonar System accurately and completely. 
However, EdgeTech assumes no liability for errors or for any damages that 
result from the use of this manual or the equipment it documents. EdgeTech 
reserves the right to upgrade features of this equipment and to make 
changes to this manual without notice at any time. 
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Warranty 

All equipment manufactured by EdgeTech is warranted against defective 
components and workmanship for a period of one year after shipment. 
Warranty repair will be done by EdgeTech, free of charge. Shipping costs are 
to be borne by the customer. Malfunction due to improper use is not covered 
in the warranty and EdgeTech disclaims any liability for consequential 
damage resulting from defects in the performance of the equipment. No 
product is warranted as being fit for a particular purpose and there is no 
warranty of merchantability. This warranty applies only if: 

i. The items are used solely under the operating conditions and in the 
manner recommended in Seller’s instruction manual, specifications, or 
other literature. 

ii. The items have not been misused or abused in any manner or repairs 
attempted thereon. 

iii. Written notice of the failure within the warranty period is forwarded to 
Seller and the directions received for properly identifying items 
returned under warranty are followed. 

iv. The return notice authorizes Seller to examine and disassemble 
returned products to the extent Seller deems necessary to ascertain 
the cause for failure. 

The warranties expressed herein are exclusive. There are no other 
warranties, either expressed or implied, beyond those set forth herein, and 
Seller does not assume any other obligation or liability in connection with the 
sale or use of said products. Any product or service repaired under this 
warranty shall be warranted for the remaining portion of the original 
warranty period only.  

Equipment not manufactured by EdgeTech is supported only to the extent of 
the original manufacturer’s warranties. 
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Warning 

This equipment contains static sensitive devices that are extremely sensitive 
to static electrical charges, which may be developed on the body and the 
clothing. Extreme care should be taken when handling these devices both in 
and out of the circuit board. Normal handling precautions involve the use of 
anti-static protection materials and grounding straps for personnel. 

This equipment generates, uses and can radiate radio frequency energy, and 
if not installed properly may cause interference to radio communications. It 
has not been tested to compliance to the appropriate FCC rules designed to 
provide reasonable protection against such interference when operated in a 
commercial environment.  Operation of this equipment in a residential area 
may cause interference, in which case the user, at his own expense, will be 
required to take whatever measures needed to correct the interference. It is 
the user’s responsibility to verify that the system complies with the 
applicable FCC emission limits. 

High Voltage may be present in the Sonar Head, power amplifier and the 
topside processor. Use caution when the electronics are removed from their 
containers for servicing. 

Operation with improper line voltage could cause serious damage to the 
equipment. 
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Software Service Agreement 

EdgeTech provides software services free of charge for one year 
following the purchase of an EdgeTech system. A Software Service 
Agreement (SSA), which is available for an annual fee, covers these 
services after the first year. The services are listed below. 

The SSA does not address customer specified modifications or 
enhancements. These services may be ordered separately. 
Furthermore, EdgeTech software upgrades are meant for the sole use 
of EdgeTech customers that have purchased a system within a year or 
have an existing SSA. Any reproduction of EdgeTech supplied software 
or file sharing is strictly prohibited. 

 

Software Updates and Enhancements 
EdgeTech customers with a SSA automatically receive regular new software 
releases with all modifications and enhancements along with user's manual 
changes. New software releases consist of the following: 

•  Software enhancements that are not on the price list 
•  Software fixes and changes 
•  Product integration 
•  Documentation updates to on-line help 
•  Tests for compatibility with other modules 

Software patches consist of software that has undergone the following: 

•  Minor software enhancements 

•  Software fixes and changes 
 

Software Performance Report 
EdgeTech customers may submit reports using a Software Performance 
Report (SPR) form. SPR forms are available from EdgeTech. This report may 
be related to a problem or to an inquiry, or it may be a specific request for a 
software enhancement. EdgeTech will attend to the SPR at a priority level 
appropriate to the seriousness of the problem and to the availability of a 
work-around. 
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Software Telephone, Facsimile and E-mail Support 
The SSA entitles EdgeTech customers to contact EdgeTech Customer Service 
by telephone, facsimile or e-mail to report a difficulty, to discuss a problem 
or to receive advice on the best way to perform a task. When contacted, 
EdgeTech Customer Service will do the following: 

•  Respond within 24 hours 
•  Immediately attend to serious problems affecting 

operations 
•  Attempt to find an immediate work-around 

 

Software Service Agreement Fee 
The SSA covers one year and is renewable upon expiration. For the SSA 
annual fee, please contact EdgeTech directly. For contact information refer 
to the Customer Service Section on page “x” of this manual. 
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Returned Material Authorization 

If it is necessary to return the equipment for service, a Returned Material 
Authorization (RMA) number is required prior to returning any equipment to 
EdgeTech.  This is to assist EdgeTech in recognizing the returned equipment 
when it arrives at EdgeTech’s receiving dock, and to assist customer service 
representatives in tracking the returned equipment while it is at EdgeTech’s 
facilities.  The material should be shipped to the address provided in the in 
Customer Service Section, located on page x of this manual.  Please refer to 
the RMA number on all documents and correspondence as well. 
 
All returned material must be shipped pre-paid. Freight collect shipments will 
not be accepted. 

The following steps apply only to material being returned from outside the 
Continental United States. Follow them carefully to prevent delays and 
additional costs. 

 1. All shipments must be accompanied by three copies of your proforma 
invoice, showing the value of the material and the reason for its return, 
if the reason is for repair, it must be clearly stated in order to come 
through customs faster and without duties being charged. Whenever 
possible, please send copies of original export shipping documents with 
the consignment. 

 2. If the value of the equipment is over $1000, the following Shipper's 
oath must be sent with the invoice. This oath can be typed on the 
invoice, or on a separate letterhead. 

"I, ______________________________, declare that the articles 
herein specified are the growth, produce, or manufacture of the United 
States; that they were exported from the United States from the port of 
_____________________, on or about _______________; that they 
are returned without having been advanced in value or improved in 
condition by any process of manufacture or any other means; and that 
no drawback, or allowance has been paid or admitted hereof." 

Signed ______________________________ 
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 3. If there is more than one item per consignment, a packing list must 
accompany the shipment. It is acceptable to combine the proforma 
invoice and packing list as long as the contents of each carton are 
clearly numbered and identified on the invoice. 

 4. Small items can be shipped prepaid directly to EdgeTech by FedEx, 
DHL, UPS, Airborne, etc. 

 5. If the equipment is the property of EdgeTech (formerly EG&G Marine 
Instruments Division) please insure for full value. 

 6. Fax one invoice, packing list, and a copy of the airway bill to EdgeTech 
upon shipment. 
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Customer Service 

Customer service personnel at EdgeTech are always eager to hear from 
users of our products.  Your feedback is welcome and is a valuable source of 
information which we use to continually improve these products.  Therefore 
we encourage you to contact customer service to offer any suggestions or to 
request technical support.  

 

For product service or support, please contact: 

EdgeTech 
4 Little Brook Road 
West Wareham, MA 02576 

 
Tel: (508) 291-0057 

 Fax: (508) 291-2491 
 

For more information please go to www.edgetech.com or email 
info@edgetech.com. 
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EdgeTech’s 4600 Reference Manual 
 

1. Introduction  

1.1 Company Background 
EdgeTech, formerly EG&G Marine Instruments, traces its history in underwater data 
acquisition and processing back to 1966.  EdgeTech has designed, developed and 
manufactured products, instruments and systems for the acquisition of underwater data, 
including marine, estuarine and coastal applications for over 40 years.  It has responded 
to the needs of the scientific, Naval and offshore communities by providing equipment, 
such as sub-bottom profilers, side scan sonar, acoustic releases, current meters, and 
positioning systems, which have become standards in the industry. Equally as 
significant, is the company's ability to anticipate and respond to future needs through an 
active research and development program. Current efforts are focused on the application 
of cutting edge chirp, DSP, and acoustic technology. 

1.2 Product Overview 
EdgeTech’s 4600 is a combined, fully-integrated, swath bathymetry and side scan sonar 
system.  The 4600 uses eight receive element transducers and one discrete transmit 
element to produce real-time, high-resolution, 3D maps of the seafloor, while also 
providing co-registered simultaneous side scan and bathymetric data.  The high number 
of channels enables good rejection of multi-path effects, reverberation, and acoustic 
noise.   

 

Figure 1:  4600 Topside Processing Unit (Left) and 4600 Sonar Head (Right) 
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The 4600 operates at one of two frequencies, 230 kHz or 540 kHz, depending on the 
model.  The sonar electronics and arrays are mounted onto a streamline body that is 
deployed over-the-bow (-or side) of a survey vessel.  Sonar data is transferred from the 
transceiver to the processing unit on board, via an Ethernet network interface.   

Default configuration for the 4600 includes an integrated sound velocity sensor and a 
built-in bottom tracker.  The system can interface with standard DFPS/RTK systems, 
MRUs, SVPs, CTDs, Altimeters, and Gyros.  Simple to use acquisition software is 
provided by EdgeTech and an approved post processing software. 

At this point, the only hydrographic surveying and post processing software that has 
been approved by EdgeTech to interface with the 4600 software is HYPACK®.  EdgeTech 
has worked exclusively with this company to provide a user friendly interface for the 
4600 System.  The 4600 Topside Processing Unit comes standard with HYPACK® pre-
installed, unless the customer has specified otherwise upon time of purchase. 

 

 

 

1.3 Supplied Components 
 4600 Swath Bathymetry and Side Scan Sonar System with 20 m (65 ft) Deck 

Cable (please refer to the Cable Drawing on page A3 of the Appendix).  
 Sound Velocity Profiler (SVP, located in the nose section of the Sonar Head) 
 4600 Topside Processing Unit – 4600 Interface and Topside Processor with 

DISCOVER 4600 Side Scan and Bathymetry Acquisition Software 
 HYPACK® Survey and Post-Processing Software 
 System Restore Software (DVD) 
 (2)  21 in LCD Monitors 
 HP Keyboard and Mouse 
 (2) Power Cables 
 Spares Kit 
 Manuals 
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1.4 Optional Equipment 
 4600 Mounting Pole (see drawing in Figure 2 on Page 4) 
 Crescent VS111 Series Hemisphere GPS (Figure 3, Page 5) 
 SMC IMU Sensor (Figure 4, Page 5) 
 HP 25 in LCD Monitor 
 Samsung 25 in LCD Monitor  

 
  
 Note: Optional equipment must be specified upon time of purchase 
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Optional Mounting Pole Example: 

 

 

 

 

Figure 2:  Mounting Pole Concept Drawing 

  

Waterline 

Tail Section 

1.02 m (3 ft) 
10 cm (4 in) 

2.1 m (7 ft) 

0.9 m (3 ft) 
Standard 

Bow of Survey Vessel 

Cable Path Protected by Fairing  
Max Cable Length = 20 m (65 ft) Ø 10 cm (4 in) 
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Optional Dual-Headed GPS System 

 

 

Figure 3:  Crescent VS111 Series Hemisphere GPS 

 

 

Optional Motion Reference Unit 

 

Figure 4:  SMC IMU Sensor 

 

 

Please contact EdgeTech for further product and purchasing information. 
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1.5 Software Description 
 EdgeTech’s DISCOVER 4600 Bathymetry and Side Scan Software Acquisition 

package provides a way to control, store, and display the bathymetry and 
side scan sonar data.  The data is presented on a color waterfall display and is 
stored in JSF formats on the hard disk of the Topside Processor.  (See 
Chapter 5, Section 2 for more information about Discover 4600)   
 

 HYPACK® Hydrographic Survey Software package provides the end user with 
all of the necessary tools needed to design their survey, collect data, process 
it, reduce it, and generate final products. 
 

 
 

Note:  The 4600 Topside Processing Unit comes standard with pre-installed 
third party software (currently only HYPACK is available), unless the customer 
has specified otherwise upon time of purchase.   
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2. System Description 

The complete 4600 system consists of a Swath Bathymetry and Side Scan Sonar Head and 
a Topside Processing Unit.  This section describes the two main components that make up 
the 4600 system and lists its specifications. 

2.1  The 4600 Sonar Head 
The 4600 Swath Bathymetry and Side Scan Sonar Head comes standard with a Sonar 
Processor, Port and Starboard Sonar Arrays, a Sound Velocity Sensor (SVS), a Nose and 
Tail Cone, and a Mounting Bracket with handles.  A Mounting Pole may be purchased 
separately to secure the 4600 System to a survey vessel.  These components are 
demonstrated in Figure 5.     

 

 

Figure 5:  4600 Sonar Head Components 

 

Note:  Please become familiar with these terms in Figure 5, as they will be referenced 
throughout the rest of this manual. 

Sections 2.1.1 through 2.1.5 give a detailed description of the standard components 
illustrated in Figure 5. 

  

Mounting Pole 
(Sold Separately) 

Sound Velocity  
Sensor (SVS) 

Nose Cone 

Tail Cone 

Sonar  
Processor 

Sonar Arrays  
(Port and Stbd) 

Mounting Bracket 
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2.1.1 Sonar Processor 

The 4600 Sonar Processor has a built in PC running Windows XP as its operating 
system.  The main firmware installed on the embedded PC is an application called 
sonar.exe.  This firmware controls the sonar’s hardware and performs specific 
functions such as the signal processing and time synchronization of the acquired 
data.  

 

2.1.2 Sonar Arrays 

The 4600 operates at one of two frequencies, 230 kHz or 540 kHz, and utilizes two 
arrays (port and starboard) to map the seafloor.  Each 4600 hydrophone array is 
constructed using 9 independent longitudinal PZT elements.  One of these is used 
only for the transmit function, while the remaining 8 elements make up an 
approximately half wavelength spaced array of sensors for its receiver.   

The 8 independent elements are connected to 8 independent receive channels that 
are used to estimate the amplitude and phase measurements.  Selected sub-
elements of each array are used to form the side scan display data. 

 

2.1.3 Sound Velocity Sensor 

The 4600 Sonar Head has a flooded section in the front that is used to house an OEM 
version of the AML SV-Xchange sound velocity sensor (SVS) with a 33 mm (1.3 in) x 
246 mm (9.5 in) sensor providing a response time of 47 μs, a resolution of 0.001 
m/s, and a theoretical accuracy of ±0.025 m/s.  A closer look at the SVS is 
presented in Figure 6. 

 
Figure 6:  SVS in Nose of Sonar Head 

 

2.1.4 Nose and Tail Cones 

The 4600 Nose and Tail Cones supply a streamline body for efficient underwater 
maneuvers.  The cones also serve as protection for the SVS at the front and the 
array and deck cable connections at the rear. 

SVS 
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2.1.5 Mounting Bracket 

The 4600 Mounting Bracket provides the user with an efficient way to carry the 
system via the two handles at the front and back of the Sonar Head.  It also offers a 
way for the user to secure the 4600 to their deployment mechanism while protecting 
the 20 m deck cable. 

 

 

2.2 The 4600 Topside Processing Unit 

The 4600 Topside Processing Unit includes a 4600 Sonar Interface and a Topside 
Processor (see Figure 7). 

 

 

Figure 7:  4600 Topside Processing Unit 

 

2.2.1  The 4600 Topside Sonar Interface 

The 4600 Interface has two purposes:  

i. to provide power to the Sonar Head and  
ii. to provide a direct link between the Sonar Head, any supporting sensors, and 

the Topside Processor.  

The interface delivers power to the system and transmits/receives data via a 20 m 
(65 ft) Deck Cable and a 20 pin Amphenol connector.  The interface also supplies two 
high speed and high accuracy (10Mbps) COM ports and a third COM port configured 
for standard connections to intake the navigation, heading, and attitude data from 
the supporting sensors.  These connections are explained in more detail in Section 
3.2.2.   

4600 Sonar  
Interface 

4600  
Topside Processor 
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2.2.2  The 4600 Topside Processor 

The 4600 Topside Processor is a high performance PC running Windows 7 as its 
operating system.  The Topside Processor is used to simultaneously execute 
EdgeTech’s DISCOVER 4600 Side Scan Acquisition software and Bathymetric 
Processing module, as well as a third party data acquisition and processing software.  
The Topside Processor also has a 1 TB hard drive to store the bathymetry and side 
scan data.   

Note:  Even though the Topside Processor may look and operate like a general 
purpose PC, it is not designed to have other software installed.  Installing other 
software besides the ones supplied with the system can have undesirable effects, 
such as poor and/or slow performance when acquiring bathymetry and side scan 
data, and the possibility of missing and/or incomplete data being acquired.  

 

2.3 Deck Cable 

The deck cable is a 20 meter (65 feet) underwater, high speed network data and power 
cable.  The deck cable includes Cat 5e 4 pair stranded conductors that meets or exceeds 
TIA 568-B and is suitable for 10Base-T and 100Base-T.  The deck cable is also 
terminated with a Seacon MINK19-CCP dry mate connector on both ends, has a breaking 
strength of 545 kg (1200 lbs), and provides power and telemetry to the 4600 system. 
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2.4 Product Specifications 
 

                230 kHz Model        540 kHz Model 

Physicals 
Size   : 1210 L x 260 W x 230 H (mm)  1210 L x 260 W x 230 H (mm) 
     47.64 L x 10.13 W x 9.18 H (in) 47.64 L x 10.13 W x 9.18 H (in) 
Weight   : 44 kg (98 lbs) 44 kg (98 lbs) 
Construction   : Aluminum and Polyurethane  Aluminum and Polyurethane 
Color   : Yellow and Black Yellow and Black 
Sealing   : Watertight Cover O-ring Seal  Watertight Cover O-ring Seal 
       with Purge Valve with Purge Valve 
 
 
Side Scan Sonar 
Frequency : 230 kHz 540 kHz 
Range (per Side) : 225 m (738 ft) 125 m (410 ft) 
Range Resolution : 30 mm (1.18 in) 15 mm (0.6 in) 
Beam Width Along Track : 0.64° (2-way) 0.5° (2-way) 
Depression Angle : 30° 30° 
 
 
Interferometric Swath Bathymetry 
Maximum Swath : 350 m 150 m 
Range Resolution : 60 mm (2.36 in) 30 mm (2.36 in) 
Ping Repetition Rate : 25 m (82 ft) = 30 Hz,  25 m (82 ft) = 60 Hz, 
  50 m (164 ft) = 15 Hz, 50 m (164 ft) = 30 Hz, 

    100 m (328 ft) = 7.5 Hz 100 m (328 ft) = 15 Hz 
Max Depth Below Tx : 120 m 50 m 
 
 
Sonar Head Power Requirements 
DC Input : 48 VDC 48 VDC 
Power : 100 Watts 100 Watts 
 
 
Environment 
Operating Temperature :  0°C to 40°C (32°F to 104°F)    0°C to 40°C (32°F to 104°F)   
Storage Temperature : -20°C to 60°C (-4°F to 140°F) -20°C to 60°C (-4°F to 140°F) 
Relative Humidity : Operating 0 to 80%,  Operating 0 to 80%, 
  Non-Operating 0 to 100% Non-Operating 0 to 100% 
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Topside Interface 
Interface : 100 baseT Ethernet 100 baseT Ethernet 
  Serial RS-232 Serial RS-232 
Power Supply : 110/220 VAC Auto-Sensing 110/220 VAC Auto-Sensing 
 
 
Topside Processor 
Operating System : Windows 7 Windows 7 
Interface : 100 baseT Ethernet,  100 baseT Ethernet 
  Serial RS-232 Serial RS-232 
Display : Dual 21” LCD Monitors,  Dual 21” LCD Monitors, 

  Expandable to 4 Expandable to 4 
Storage  : 1TB min Hard Drive & RW-DVD 1TB min Hard Drive & RW-DVD 
Power Supply :         110/220 VAC Auto-Sensing      110/220 VAC Auto-Sensing 
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3. System Formats and Connections  

This section describes the systems data formats, connections, and diagrams for hardware 
and data. 

3.1 Data Formats 
In order to collect valid survey data, the following is required to support the survey 
operations and correct processing of the 4600 Bathymetry and Side Scan echo data: 

a. GPS Position in NMEA format, latitude and longitude 
b. Heading data in NMEA format or EM1000 binary format 
c. Attitude or Roll, Pitch and Heave data in TSS1 or EM1000 binary format 
d. Time sync data in NMEA format 

This data may be supplied by 1, 2, or 3 individual sources. 

a. Position Data – this may be supplied via any of the following NMEA type 
sentences/messages: 

i. $xxGGK  ** (Applanix PosMV Format) 
ii. $xxGGA 
iii. $xxGLL 
iv. $xxRMC 
v. $PTNL, GGK, …  ** (Trimble Format) 

** = Non-NMEA standard sentences 

b. Heading Data – this maybe input via: 
i. NMEA, $xxHDT sentence, or 
ii. EM1000 binary format along with attitude data 

 
c. Attitude (Roll, Pitch, and Heave) Data – this may be input via: 

i. EM1000 binary format, or 
ii. TSS1 format 

 
d. Time Input - supported sentences are in order of (priority/use) 

i. $xxZDA 
ii. $xxGGK (derived from data in item a. above) 
iii. $xxGGA 
iv. $xxRMC 
v. $xxGLL 
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3.2 System Connections and Data Flow 
 

3.2.1  Ethernet LAN Connections 

The Ethernet LAN connection from the Sonar Head to the 4600 Topside Interface is 
made using a physical wired connection via the standard 20 m deck cable.  This 
cable is fixed to the Sonar Head and provides a Seacon 19 pin connector for direct 
connection from the Sonar Head to the 4600 Sonar Interface.  The 4600 Sonar 
Interface then connects to the Topside Processor via a standard RJ-45 Ethernet plug.  
The Topside Processor auto-senses straight and crossover Ethernet cables. 

 

3.2.2  COM Ports 

There are three COM ports provided on the 4600 Sonar Interface.  COM1 and COM2 
have been configured for high speed and high accuracy (10Mbps).  COM3 is 
configured for standard connections.  These COM ports are provided to intake the 
navigation, heading, and attitude (roll, pitch, and heave) data from the supporting 
sensors.  (Please see Appendix A on how to configure the COM ports) 

 

3.2.3  Hardware Data Flow 

Figure 8 is a block diagram that illustrates the interconnections between the 4600 
Swath Bathymetry and Side Scan Sonar System, the 4600 Topside System, and all 
supporting sensors. 

A more detailed block diagram demonstrating the interconnections and inputs to the 
4600 Sonar Interface is shown in Figure 9.  This illustration also gives three 
examples of possible sensor configurations.  A larger representation of Figure 8 and 
Figure 9 are given in Appendix B. 
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Figure 8:  Hardware Data Flow Diagram for the 4600 System 

 
Figure 9:  Sonar Interface Connections 
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In Figure 8, the 4600 Sonar Interface connects to the Sonar Head via the Seaconn 
19 pin connector and Deck Cable.  Navigation, heading, roll, pitch, and heave data 
from the supporting sensors via COM ports 1, 2, and/or 3, are inputted at the Sonar 
Interface, passed through the Deck Cable, and logged by the Sonar Processor in the 
Sonar Head.   

These data are then transmitted, along with the raw side scan data, with a common 
timestamp up the deck cable to the 4600 Sonar Interface, and passed to the Topside 
Processor through the Deck Cable and via Ethernet Port 1 (IP Address: 192.9.0.100).   

The Topside Processor then processes these data using the DISCOVER and 
Bathymetry software to send amplitude, angle and range data to the HYPACK® 
software for logging and post processing.  This process is explained in further details 
in the following section.  The HYPACK® and DISCOVER Side Scan/Bathymetry 
processors all run on the same computer. 

The first example in Figure 9 depicts an Applanix PosMV system interfacing to the 
4600 Sonar Interface.  This type of system provides navigation (latitude/longitude), 
heading, roll, pitch, and heave data and so no other sensor is required.  The PosMV 
should be connected to COM1 or COM2. 

The second example shows the most common interfacing scenario, a GPS that 
provides navigation and heading data, accompanied by a motion sensor for attitude 
measurements.  The COM ports should be assigned as such: 

 COM1 = GPS (Navigation and Heading) 
COM2 = MRU (Roll, Pitch, Heave) 

These assignments may be interchanged between COM1 and COM2 because both 
ports have been configured for high speed and high accuracy.  COM3 should not be 
used in this scenario. 

The third and last example portrays the situation where the supplied GPS does not 
provide heading data.  In this case, three sensors are required – a GPS for 
navigation (latitude/longitude), a Gyro for heading, and a motion sensor for roll, 
pitch, and heave measurements.  Therefore, all three COM ports should be used and 
assigned as follows:  

COM1 = Gyro (Heading) 
COM2 = MRU (Roll, Pitch, Heave) 
COM3 = GPS (latitude/longitude) 
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The sensors allocated to COM1 and COM2 may be interchanged because of the same 
reason stated above in the second example.  The GPS data, or latitude and longitude 
data, must be allotted to COM3, because it is not as accurate as the first two 
measurements. 

Note: To configure the COM ports according to the examples given above, please 
see Appendix A. 

 

3.2.4  Sonar Data Flow 

To illustrate the data flow between DISCOVER, the Bathymetry Processor, and 
HYPACK, the block diagram in Figure 10 is used. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 10:  Sonar Data Flow 

 
As demonstrated by the flow chart, the 4600 Sonar Interface acquires the heading, 
position (latitude/longitude), and motion (roll, pitch, and heave) data and relays this 
information to the 4600 Sonar Head via the Deck Cable.   
Here, the information is combined with the raw sonar data, time stamped with a 
common value, and sent back to the 4600 Sonar Interface.   

4600 Sonar 
Interface 4600 Sonar Head 

Heading, Position, 
and Motion Data 

DISCOVER 

Information Gets Time Stamped 
and Sent Back to Interface 

HYPACK® 

Raw Sonar Data  
+ Supporting Data 

Supporting Data 

Raw Sonar 
Data 

Supporting  
Data 

Range/Angle Data + 
Supporting Information 

Bathymetry 
Processor 

Raw Sonar 
Data 

Range/Angle 
Data 

Side Scan Data 

HSX  
Files 



        
 
 

4600 REFERENCE MANUAL PAGE 18 OF 68 REV G 
 

4600 Swath Bathymetry  
and Side Scan Sonar 

 
DISCOVER intakes the raw sonar data and sends it to the Bathymetry Processor, 
where the raw data is converted to range and angle data.   
 
The Bathymetry Processor transmits this range/angle data back to DISCOVER, where 
it is then displayed on the monitor, packaged with the heading, position, motion, and 
side scan data, and recorded as a *.JSF file.   
 
This complete data package is then sent to and used by HYPACK to generate three-
dimensional bathymetry data files and to display side scan and bathymetry data on a 
monitor.   
 
Finally, these three-dimensional bathymetry data files (.HSX) can be used post 
survey to generate hydrographic final products. 
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4. System Assembly and Installation 

Assembly and installation of the EdgeTech 4600 Swath Bathymetry and Side Scan Sonar 
System encompasses unpacking, inspecting, and connecting the system’s components, 
connecting the supporting sensors, and verifying that the system operates correctly using 
EdgeTech’s DISCOVER 4600 and third party software.  This section provides instructions on 
how to perform these tasks. 

 

4.1 Unpacking and Inspecting 
The Sonar Head, Topside Processing Unit, and supporting sensors are shipped in 
separate, reusable, heavy duty transport cases.  The necessary cables, spares kit, and 
documentation are also included.  Before unpacking the system’s components, inspect 
the shipping containers for any damage.  If any damage is noticed, please report it to 
the carrier and to EdgeTech immediately.  If the shipping containers appear damage 
free, carefully unpack the components and inspect them.  Also, pleases check the 
packing list and verify that all the items on the list are included.  Again, if any damage is 
found, please report it to the carrier and to EdgeTech immediately.  If any items are 
missing, please contact EdgeTech using the information provided on page x.  Do not 
install or operate any equipment that appears to be damaged. 

Although the items shipped may vary, depending on the customer’s requirements, the 
standard components for the 4600 Swath Bathymetry and Side Scan Sonar system are 
listed in Section 1.3. 

 

4.2 Sonar Head Assembly 
The 4600 streamline body system includes the Sonar Processor, two Hydrophone Arrays 
(one Port and one Starboard), a Nose and Tail Cone, a Mounting Bracket with handles, a 
Sound Velocity Sensor (located in the Nose section of the Sonar Head and is described in 
Section 3.2), and a 20 m Deck Cable. 

Note:  The 4600 Sonar Head is sent to the customer pre-assembled.  If for some 
reason, the system had to be disassembled, please use this set of instructions to re-
assemble the Sonar Head.  EdgeTech does not recommend anyone, other than trained 
EdgeTech engineers, to assemble and/or disassemble the 4600 system.   
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Figure 11:  Sonar Head Components (Deck Cable Not Shown) 

 

This section explains how to assemble the 4600 Sonar Head. 

1. Secure the Nose Cone to the front of the Sonar Processor using six 3/8 – 16 x ¾ 
inch socket cap screws and a 5/16 inch Allen wrench.  The front of the system 
can be identified by the section of the cylindrical body that houses the SVS 
(Figure 11). 
 

2. Attach the Port Array to the port side of the Sonar Processor using six 3/8 – 16 x 
¾ inch button socket cap screws, six 3/8 inch split lock washers, and a 7/32 inch 
Allen wrench.  Ensure the connectors are facing the tail section (opposite of the 
SVS section).  The Port and Starboard Arrays are identical but usually EdgeTech 
designates the array with the lowest serial number as the Port Array.  The serial 
number can be found on the color coded plate in the front of the array (opposite 
of the connectors). 

 
3. Attach the Starboard Array in the same manner as in Step 2. 
 
4. Connect the Port and Starboard Arrays to the Sonar Processor as in Figure 12; 

where J2 mates to the starboard array’s transmitter via the Subconn 5 pin male 
connector (MCIL5M-P), J3 couples to the starboard array’s receivers via the 
Seacon 19 pin female connector (MINK19-CCP), J5 connects to the port array’s 
transmitter via the Subconn 5 pin male connector (MCIL5M-P), and lastly J6 

Mounting Pole 
(Sold Separately) 

Sound Velocity  
Sensor (SVS) 

Nose Cone 

Tail Cone 

Sonar  
Processor 

Sonar Arrays  
(Port and Stbd) 

Mounting Bracket 
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couples to the port array’s receivers via the Seacon 19 pin female connector 
(MINK19-CCP).   

 
 

 

Figure 12:  Sonar Processor Connections on End-Cap 

 

5. Orient the Mounting Bracket on top of the Sonar Processor so that the longest 
part of the keyway is pointing towards the tail section as shown in Figure 13. 
 
 
 

 

 

Figure 13:  Top View of Mounting Bracket on Sonar Head 

 

6. Lift the Mounting Bracket and feed the tail end of the 20 m Deck Cable through 
the provided keyway (Figure 14).  The tail end of the Deck Cable has the 
Seaconn 19 pin female connector (MINK19-CCP). 
 

Nose Tail 

Keyway 

Port Starboard 
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7. Ensure the Deck Cable stays within the slotted region of the keyway on the 
Mounting Bracket and pull the cable towards the tail section (Figure 14). 

 
8. Connect the Deck Cable to the Sonar Processor using the Seacon 16 pin female 

connector (MINK16-CCP) to J1, as indicated in Figure 12 and Figure 14. 
 

 

   

Figure 14:  Connecting the Deck Cable to End Cap 

 

9. Secure the Mounting Bracket to the top of the Sonar Processor using four 3/8 – 
16 x ¾ inch button socket cap screws, four 3/8 inch split lock washers, and a 7/32 
inch Allen wrench. 
 

10. Attach the Tail Cone to the tail section of the Sonar Processor using six 3/8 – 16 x 
¾ inch socket cap screws and a 5/16 inch Allen wrench. 

 

-    Assembly Complete    - 

  

Cable Path 
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4.3 Positioning the Topside Processing Unit 
The Topside Processing Unit should be located and set up in a dry, sheltered area on the 
survey vessel that is protected from weather and water spray.  The temperature should 
also consistently be between 0°C and 40°C (32°F and 104°F).  Avoid areas of direct 
sunlight, especially in tropical environments, as heat build-up can occur and viewing the 
LCD monitor and status indicators can become difficult.  The location should also enable 
direct communications with the deck crew that is operating the survey vessel, Sonar 
Head, and other supporting sensors.  Secure the Topside Processing Unit in place near 
the required power source. 

 

 

4.4 Topside Connections  
After the Sonar Head has been installed, and the Topside Processing Unit correctly 
placed on the survey vessel, the supporting sensors can now be connected.  This section 
describes how to interconnect the supporting sensors, Sonar Head and Topside 
Processing Unit. 

1. Connect the provided two HP monitors to the back of the Topside Processor via 
the DVI connectors. 
 

2. Position the monitors on the vessel accordingly and power them ON. 
 
3. Connect the keyboard and mouse via the USB ports on the back of the Topside 

Processor. 
 
4. Turn ON the Topside Processor via the power switch on the front of the Topside 

Processing Unit. 

Note:  If the Topside Processor does not turn ON, check to see if the switch next 
to the PC’s power cable (on the back of the Topside Unit) is in the ON position.  If 
not, please flip the switch to the ON position. 

5. Position and secure a MRU to the vessel’s center of motion.  If the mounting pole 
was purchased from EdgeTech, an alternative way to attach the MRU is to the top 
of this mounting pole. 

6. Measure the location of the Sonar Head relative to the MRU.  If the MRU was 
attached to the Sonar Head’s mounting pole, measure the relative location of the 
MRU to the vessel’s center of motion.   

Note:  These measurements are important and will be used later as Offsets in 
HYPACK.  So please make sure to measure and note the exact location of the 
MRU to the vessel’s center of motion. 
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7. Setup the GPS as described in the GPS’s user manual. 

8. Connect the Sonar Head to the 4600 Topside Interface via the Seaconn 19 pin 
connector. 
 

9. Connect the dual headed GPS to COM1 and the MRU to COM2 (or vice versa). 
a. A GPS is used to gather heading and position (latitude/longitude) data. 
b. A MRU is used to measure the pitch, roll, and heave of the survey vessel. 

 

Note: Please refer to Section 3.2.2 for more information on connecting the COM 
Ports.  Also, please use Appendix A to configure the COM ports for the individual 
sensors. 
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4.5 Sonar Head Installation  
The 4600 System’s installation on the survey vessel is the customer’s responsibility, and 
certain considerations need to be kept in mind.  The Sonar Head can be mounted on the 
side of a vessel, but it is recommended to secure the 4600 to the bow of the boat.  
Consideration must be given to keel clearance for both cases.  This section outlines the 
4600 Sonar Head deployment options. 

Note: If interested in purchasing the optional mounting pole for the 4600 installation, 
please contact Customer Service for a quotation using the information provided on page 
x. 

 

4.6.1 Over-the-Bow Deployment 

The first and recommended option is to mount the 4600 Sonar Head to the bow of 
the survey vessel.  An example of an over-the-bow deployment is depicted in the 
photographs in Figure 15.  A larger representation of these photographs is given in 
the Appendix on page B1.  If help is needed with this type of installation, please do 
not hesitate to contact EdgeTech using the information provided in the Customer 
Service Section on page x of this manual. 

 

 

Figure 15:  4600 Deployment, Option 1:  Over-the-Bow 
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4.6.2 Over-the-Side Deployment 

An alternative to the latter is to mount the 4600 Sonar Head over the side of the 
survey vessel.  An example of an over-the-side deployment is illustrated in the 
images in Figure 16.  A larger representation of these photographs is given in the 
Appendix on page B2.  If help is needed with this type of installation, please do not 
hesitate to contact EdgeTech using the information in the Customer Service Section 
on page x of this manual. 

 

     

Figure 16:  4600 Deployment, Option 2:  Over-the-Side 
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4.6 Care and Maintenance 
The 4600 System was not designed for long term deployments and it is not 
recommended to keep the system in water for more than two weeks.  After each mission 
the system should be rinsed thoroughly with freshwater, making sure to rinse the SVS at 
the front and connectors at the back using the provided rinse holes in the nose and tail 
cones.   
 
The faces of the arrays should also be inspected after every deployment for organism 
growth or damage.  If any residue is noticed, clean the array faces using a wash cloth 
with mild soap and water.  If any damage is observed, contact EdgeTech Customer 
Service immediately.     
 
In addition, the SVS sensor should be inspected regularly.  If fouling is observed on the 
sensor, carefully clean it based on the manufacturer’s recommendations.  The sensor 
does not need regular calibration, but it is suggested to have it calibrated at least once 
every two years. 
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5. Principles of Operation 

This section describes how to operate the 4600 system in order to collect data with 
DISCOVER and your third party topside interface.   

5.1 Confirming Supporting Data is Present 
To ensure the Sonar Head’s processing unit is communicating properly with the Topside 
Processor, follow these steps. 
 

1. On the Desktop, launch Shortcut to sonar.exe.  The following window should 
appear. 

 

Figure 17: Sonar 192.9.0.101 Remote Desktop Connection Window 

2. Click on Menu > Misc > Serial Port Information… 
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3. Check each COM port in the drop down menu to ensure data is coming through 

for each device and in the correct format (Figure 18). 
a. COM1 = MRU 
a. COM2 = GPS 
b. COM4 = Sound Velocity Sensor in the nose of the Sonar Head 

 
Note:  The GPS and MRU are interchangeable on COM1 and COM2 as long 
as the appropriate baud rate is set in the drop down menu next to the 
channel assignment in the Serial Port Information Window (Figure 18, red 
arrow). 
 
More information on how to configure the COM ports is presented in 
Appendix A. 

If all systems are working properly, close this window and proceed to Step 5.  If 
there is an issue with one of the ports, please contact Customer Service using the 
provided information on page x.   

4. Now click on Menu > File > Show Status.  The System Status window will 
appear as shown in Figure 19. 
 

5. On the right hand side of the window, click on the Config bullet under the 
Update button and then on the drop down menu named Config Item. 
 

6. Select Serial and then click the Update button several times. 
 
7. Check to make sure all sensors’ usage percentages are well below 80%.  If they 

are not; increase the baud rates of the sensors until these percentages drop.  
Make sure to change the baud rate accordingly in Sonar. 
 

8. When satisfied with the incoming data, press OK in the System Status window 
and then minimize the Sonar – 192.9.0.101 – Remote Desktop Connection 
window. 
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Figure 18:  Serial Port Information Window 
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Figure 19:  System Status Window 
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5.2 DISCOVER 4600 
EdgeTech’s DISCOVER display and control application allows recording of side scan and 
range/angle bathymetry data in the binary EdgeTech JSF file format.  The JSF file 
format has been in use for 10+ years and has new public extensions to support the 
additional bathymetry data messages.   
 
This section describes DISCOVER and the BATHYMETRIC PROCESSOR entirely and how 
to operate them during a survey. 
 

1. Launch DISCOVER 4600 using the Desktop shortcut.  The two main windows will 
appear as in Figure 20. 

 

 

 
 

Figure 20:  DISCOVER Main Window and BATHYMETRIC PROCESSOR

A - 
B - 

C - 
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The DISCOVER Main Window contains a Top MenuA, a Toolbar MenuB, and a 
Control MenuC.  These menus are illustrated in Figure 20 and correspond to A, B, 
and C, respectively.  A brief description of the shortcut keys in the DISCOVER 
Toolbar Menu and the DISCOVER Control Menu are given on page 39 through 44.  
The Top Menu is not described because it is self-explanatory. 

 

The BATHYMETRIC PROCESSOR is the built in module that is responsible for 
computing the seafloor solutions.  It displays the number of processed pings, the 
last altitude found by the BATHYMETRIC PROCESSOR and the number of angle 
sets used in the seafloor calculations.   

 
Figure 21: Bathymetric Processor Module 

Note:  The BATHYMETRIC PROCESSOR will restart if you press the “x” up at the 
top right corner.  In doing so, the BATHYMETRIC PROCESSOR will delete all 
current settings and revert back to its default configuration.  Please refrain from 
pressing the “x” on the BATHYMETRIC PROCESSOR window. 
 

2. If the EdgeTech 4600 is powered on and connected to the 4600 Topside Interface 
box, then ensure that the Sonar Head is connected to DISCOVER by ensuring the 
network is on (NET: ON) down in the right hand corner of the DISCOVER main 
window (as pointed to by the blue arrow in Figure 22). 
 
 

 
 

Figure 22: NET ON in Discover 
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DISCOVER Toolbar Menu 

The DISCOVER Toolbar Menu permits the user to have easy access to certain 
features in the Top Menu and Control Menu.  The Toolbar Menu (list B in Figure 
20) is demonstrated in Figure 23 with an explanation for each. 

 

 

Figure 23:  DISCOVER Toolbar Menu 

 
i. Playback – Replays a previously collected side scan file.  This feature can also 

be accessed under the DISCOVER Control Menu on the Disk Tab. 
 

ii. Pause Playback – Pauses a previously collected side scan file.  This feature 
can also be found under the DISCOVER Control Menu on the Disk Tab. 

 
iii. Stop Playback – Stops a previously collected side scan file.  This feature can 

also be found under the DISCOVER Control Menu on the Disk Tab. 
 

iv. Fast Forward – Fast forwards a previously collected side scan file.  This 
feature can also be found under the DISCOVER Control Menu on the Disk 
Tab. 

 
v. Sonar On – Toggles the 4600  System On/Off.  This feature can also be found 

under the DISCOVER Control Menu on the Towfish Control Tab. 
 

vi. Normalize Data – Normalizes the side scan data with respect to the highest 
intensity.  This feature can also be found under the DISCOVER Control Menu 
on the Video Gains Tab. 

 
vii. Decrease Gain – Decreases the gain with respect to the highest intensity.  

This feature can also be found under the DISCOVER Control Menu on the 
Video Gains Tab. 

 
viii. Current Gain Value – Shows the current gain value with respect to the highest 

intensity.  This feature can also be found under the DISCOVER Control Menu 
on the Video Gains Tab. 

 
ix. Increase Gain – Increases the gain with respect to the highest intensity.  This 

feature can also be found under the DISCOVER Control Menu on the Video 
Gains Tab. 

 

i ii iii iv vi vii viii ix x xi xii xiii xiv xv xvi v 
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x. Auto Set TVG – Automatically sets the Time Varying Gain (TVG).  This control 

compensates for spherical spreading and attenuation losses.  This feature can 
also be found under the DISCOVER Control Menu on the Video Gains Tab 
and is called Norm TVG. 
 

xi. Decrease TVG – Decreases the TVG.  This feature can also be found under the 
DISCOVER Control Menu on the Video Gains Tab. 

 
xii. Current TVG Value – Shows the current TVG value.  This feature can also be 

found under the DISCOVER Control Menu on the Video Gains Tab. 
 

xiii. Increase TVG – Increases the TVG.  This feature can also be found under the 
DISCOVER Control Menu no the Video Gains Tab. 

 
xiv. Mark – Places a mark in the recorded data where something might be of 

interest (this mark can be seen during playback).  This feature is only located 
in the DISCOVER Toolbar Menu.  

 
xv. Reset Displays – Resets the screen to the default display.  This feature is only 

located in the DISCOVER Toolbar Menu. 
 

xvi. Toggle Speed Correction – Toggles speed correction on/off.  This function 
adjusts the display settings to make the image look more proportioned and is 
only located in the DISCOVER Toolbar Menu. 
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DISCOVER Control Menu 
 
The DISCOVER Control Menu allows the user to turn the towfish on/off, adjust the 
range and gains, playback or record a side scan file, and displays the towfish 
status.  These windows are displayed and described over the next few pages. 

 

Towfish Control 

Navigate to the Towfish Control Tab to turn the sonar On/Off by checking the 
Sonar On box or by clicking on the ON button from the Shortcut Menu.  The range 
(m) and ping rate (%) can also be adjusted from this control menu.  The range is 
specified per side.  In the example below, the total swath is 200 m. 

 
Figure 24:  Towfish Control Tab 

Note: If at any time, one or more of the systems (i.e. GPS, MRU, Sonar Head) 
have been disconnected or are not sending data to DISCOVER while the Sonar 
Head is ON, a window (Figure 25) will appear displaying the unavailable system(s).   
 
If this window appears, check the connection to the unavailable system(s).  If the 
problem persists, please call Customer Service using the information provided on 
page x. 

 

 

Figure 25:  Diagnostic Window 
 

Video Gains 

 

 

Sonar Head is ON 
and CONNECTED 

SVS is ON and 
CONNECTED 

GPS/IMU is DISCONNECTED 
IMU/GPS is DISCONNECTED 
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The user can adjust the gain levels in DISCOVER to facilitate the viewing of the 
side scan waterfall.  These levels can be regulated one of two ways. 

a. Using the Video Gains Tab (Figure 26) 
b. Using the Shortcut Menu on DISCOVER’s main window (Figure 23, buttons vi 

through xiii). 

The user can also adjust the Gain and TVG manually by either typing in the desired 
value or increasing/decreasing the value using the arrow buttons. 
 

 
Figure 26:  Video Gains Tab 

Note:  The gains are strictly used for viewing purposes and do not affect the 
processing of the bathymetry or side scan data. 

 

 

Display 

The user can adjust the zoom and color palette by utilizing the Display Tab.  These 
features are used solely on the customer’s preferences. 
 

 
Figure 27:  Display Tab 
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Disk 

To set up a recording directory, navigate to the Disk Tab and click Browse (red 
arrow).  Usually the recording directory is located on the F:\Data Disk on the 
Topside Processor.  When ready, press the Record button on the right hand side of 
the Disk Tab.  The name of the file will appear in the Record File: box. 

If the user does not specify a specific file name, DISCOVER will automatically name 
every file according to the date and time (UTC) the user hit record.  For example, if 
the user hit record at 13:18 (UTC) on July 12, 2012 the file name will be recorded 
as 20120712131822.jsf.   
 

 
Figure 28:  Disk Tab 

For basic playback, navigate to the Disk Tab (Figure 28) and select Browse (green 
arrow).  Locate the desired JSF file and use the function buttons to play, stop, fast 
forward, etc.  These playback buttons are also conveniently located on the Shortcut 
Menu. 

Note:  If a file was recorded in DISCOVER while data was being recorded in the 3rd  
party acquisition software, the file can be re-processed for bathymetric estimation 
using different parameters post-survey (please see Section 5.2.1 for more details).  
This recorded DISCOVER file provides useful for debugging and training purposes.   

 

Grids 

DISCOVER also has the option to place a grid on the screen.  The grid may 
facilitate measuring the size of a target or estimating its range from the sonar.  
The Grids Tab allows the user to place horizontal or vertical grids and to adjust the 
size and scale of these grids. 
 

 
Figure 29:  Grids Tab 
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Status 

The Status Tab conveniently displays all of the important information for the 
system, such as navigation and sensor data. 

 
Figure 30: Status Tab 
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5.2.1  Other Features in DISCOVER 4600 

There are other features in DISCOVER that may be used during a survey.  These 
functions are explained in this section. 

 

Basic Bathymetry 

To adjust the basic bathymetric processing parameters in DISCOVER, select 
Bathymetry from the Top Menu (designated as row A in Figure 20) and then 
Processing Parameters (Figure 31 and Figure 32). 
 

 

Figure 31: Discover 4600 Top Menu - Selecting Bathymetric Processing Parameters 

 

Here you can turn on/off the BATHYMETRIC PROCESSOR, adjust the echo strength 
(1/10%), SNR filter (dB), and Minimum Process Range (m). This window also 
allows you to specify if you would like to use/not use the external limits given by 
the 3rd Party Interface.  The recommended parameters are shown in Figure 32 for a 
silty/sand type seafloor. 
 

   

Figure 32:  Basic Bathymetry 

 

1 

2 

3 

4 
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A few important things to know about basic bathymetry are discussed in items 1 
through 4 and are highlighted in Figure 32. 

1. If the Bathymetric Processing box is unchecked during real time acquisition, 
the system will act as a simple side scan system and will not compute or 
acquire any bathymetric solutions.  If this is the case, the BATHYMETRIC 
PROCESSOR will remain dormant as in Figure 33. 
 

 

Figure 33: Disabled BATHYMETRIC PROCESSOR 

If the Bathymetric Processing box is unchecked during playback, DISCOVER 
will playback the file exactly as it was collected.  If the box is left checked, the 
BATHYMETRIC PROCESSOR will recalculate the seafloor solutions based on the 
parameters set in Figure 32.  So during acquisition and playback it is very 
important to pay attention to this feature.  Typically this box is always checked 
because the Discover is normally used during real time acquisition. 
 
 

2. The Echo Strength Filter is a fundamental attribute that is used primarily to 
exclude or trim weak echo points from the data, (i.e. water column and very 
weak backscatter amplitudes).  The data points have an amplitude that can 
span 0 to 32,767.  Typical sea floor echoes are above 300 to 1800, depending 
on the bottom type.  The values that can be inputted to the system are based 
on 1/10% of this span, meaning that an echo strength of 320 is realistically 
320/32767 x 100% = 0.98, and so the value that would be inputted to the 
system would be 1. In Figure 32 the input is 2, meaning that the seafloor 
echoes have an amplitude of approximately 650. 
 
 

3. The SNR Filter is a valuable statistic used to trim bad data points near the 
outer swath, where the angle noise is high due to multipath effects.  SNR 
values greater than 20 dB are excellent in terms of angle estimation noise, and 
less than 5 dB is very poor.  Useful thresholds are between 5 – 20 dB, 
depending on the desire to have maximum swath (more noise) or lower noise 
and less swath.  Typically this filter is set between 12 and 18 dB.  
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4. The Minimum Processing Range acts like a blanking range but in terms of 

slant range.  The sonar will not process any data until it has reached this slant 
range limit.  The default value is set to 1 m.  Typically this parameter is not 
adjusted unless the user is surveying within constant deep water (greater than 
50 m).  If this is the case, the user may adjust this value to a much larger slant 
range (i.e. 5 – 10 m).  

 
Another parameter the user should be aware of in terms of basic bathymetry is the 
Last Altitude (circled in green in Figure 34).     
  

 

Figure 34:  Bathymetric Processor 

This value states the last depth the BATHYMETRIC PROCESSOR has calculated, in 
meters.  If this value momentarily flashes red, it means that the BATHYMETRIC 
PROCESSOR has lost track of the bottom and will retain the last depth found for a 
short period of time.  If the BATHYMETRIC PROCESSOR cannot find the bottom after 
several pings, this value will fall to 0, and will remain at 0 until it can find or track 
the bottom again.  If this should happen, the advanced processing parameters 
should be used to help the module find the bottom again (unless of course the 
seafloor has surpassed the operating limits of the sonar).  The advanced parameters 
are discussed in the following section. 
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Advanced Bathymetry 
 
To access the advanced processing parameters in DISCOVER, select Bathymetry 
from the Top Menu (Figure 35) and then Advanced Controls (Figure 36).  Here 
you can disable/enable Auto Detect Altitude, adjust the multipath suppression 
levels and the maximum across track average size (m), and refine the advanced 
processing parameters.   
 

 

Figure 35:  Discover 4600 Top Menu - Selecting Advanced Controls 

 

 

Figure 36:  Advanced Bathymetry 

These settings are described in detail.  Please refer to Figure 36 for each 
description. 



        
 
 

4600 REFERENCE MANUAL PAGE 49 OF 68 REV G 
 

4600 Swath Bathymetry  
and Side-Scan Sonar 

 

 

1. Auto Detect Altitude:  This function tells the Bathymetric Processor to use its 
highly sophisticated algorithms to track the bottom.  If the Auto Detect Altitude 
box is unchecked then the user has the opportunity to input a value in which 
they think the bottom resides. 
 

 

Figure 37:  Auto Detect Altitude Disabled 

This feature should always be checked unless the system is tested under 
extreme circumstances.  For example, if the bathymetric processor consistently 
fails to determine the altitude due to a complex environment, the user would 
then disable this function.  Such a complex environment (shown in Figure 380 
can include surveying next to a large coral reef, where one array sees the reef 
bank and the other array does not see anything because there is nothing other 
than open ocean (would look like water column data).  The user would 
determine the range to the reef bank (shown in Figure 38) and input this 

1 

2 

3 



        
 
 

4600 REFERENCE MANUAL PAGE 50 OF 68 REV G 
 

4600 Swath Bathymetry  
and Side-Scan Sonar 

number into the Manual Altitude box (Figure 39).  For the example below, the 
user would input 32 m (Figure 39). 

 

Figure 38: Example Extreme Circumstance - Surveying next to a reef bank 

 

Figure 39: Example Extreme Circumstance - Input Approximate Depth 

 

2. Multipath Suppression Level:  The multipath suppression level is a 
parameter that is used to specify how the beam forming is calculated.  The data 
from the 8 half wavelength spaced elements can be combined prior to phase 
estimation processing to combat the effects of multipath signal propagation. 
Seafloor echoes arriving at the array from single or multiple bounces off  the 
seafloor and the sea surface are the primary cause of poor angle estimation 
and across track range limitations in a shallow water deployed system. In deep 
water deployments, as may be seen on ROV or AUV mounted systems, this 
effect is much reduced, if not eliminated.  This parameter can take values 
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between 1 and 3 and increasing this value combines more of the elements to 
combat the effects of multipath echoes.  

a. If this is set to 1, then no multipath suppression is applied and all 8 staves 
are used in the angle estimations. In the absence of multipath errors, this 
will result in good data. 

b. If this is set to 2, then adjacent element pairs are combined to help reject 
weak multipath echoes, resulting in 7 synthesized half wavelength spaced 
elements. 

c. If this is set to 3, then 3 adjacent elements are combined to help reject 
strong multipath echoes, resulting in 6 synthesized half wavelength 
spaced elements. 

 
In normal shallow water deployed systems, using a value of 3 gives the best 
result. 
 

Maximum Across Track Average Size: In estimating the angles across track, 
multiple adjacent time samples may be combined to improve the signal to noise 
ratio prior to phase estimation.  This is also a form of spatial averaging, which 
can be applied to the data prior to the angle estimation processing. This 
parameter determines the maximum across track region size that will be used 
in forming these averages, and is specified in meters.  For output data with 
very high across track resolution, this value should be kept small, for example 
0.05 to 0.5m (5 to 50 cm). For less resolution and more averaging, region sizes 
up to 1m can be used to produce good effects in some cases (deep water). 

 
3. Processing Refinements:  These parameters are explained in detail in order 

of appearance. 
 

 

Figure 40:  Processing Refinements - Advanced Controls 

a. The default setting for the Bottom Track Data Source is Product.  This 
means the BATHYMETRIC PROCESSOR takes the product of the information 
coming from both arrays to estimate the seafloor depth.  This setting seems 
to work well in most scenarios, especially for heavy boat traffic areas where 
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boat wake is prominent, but three other parameters have been added for 
those special cases a user may face.  These three other settings are Port, 
Starboard, and Sum.  

The Port and Starboard settings state that the BATHYMTERIC 
PROCESSOR should only use the port or starboard side only to compute 
the seafloor depth.  For instance, if the 4600 is mounted on the side of a 
survey vessel, there is the possibility that the 4600 will observe one or 
more hull echoes on its side facing the boat.  If this is the case, you 
would choose the Bottom Track Data Source to be the clear side, 
whether that be Port or Starboard (as shown in Figure 41).   

 
 

 
 

Figure 41: Boat Echo Example 

This tells the BATHYMETRIC PROCESSOR to use the clear side only when 
tracking the seafloor.  If it were to use the side facing the boat, there is 
a chance that the BATHYMETRIC PROCESSOR will use the hull echo as 
its first bottom return, therefore locking the bottom tracker to the hull 
echo, leading to false measurements. 
 
Another case where Port or Starboard may be used is if one of the 
arrays should fail, or the seafloor is beyond the limits of the sonar.  This 
way the user will still be able to carry out a survey, even though one 
side of the system does not work, or does not see the seafloor. 
 
The Minimum setting tells the BATHYMETRIC PROCESSOR to use the 
lowest amplitude return for the bottom tracking algorithm.  In this case, 
if there were any high amplitude points within the water column, the 
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BATHYMETRIC PROCESSOR would ignore these points and search for the 
points that had the lowest amplitude. The bottom track function would 
then lock on to those lowest amplitude points, (which is hopefully the 
bottom) and track these accordingly. 
 
Lastly, Sum tells the BATHYMETRIC PROCESSOR to sum the information 
from both sides of the arrays to calculate a depth estimate for the 
seafloor.  This parameter is the least effective of the four and should 
rarely be used. 
 
 

b. Quality Filter (%): In practice, measured interstave phases may either 
agree quite well, +/- 5° to 10°, or not at all, up to +/- 90°.  The quality filter 
metric is a measure of how good the interstave measurements are and is 
defined as 

100% = phase differences equal to 0 (i.e. not possible in practice; 
setting the quality factor to 100% will exclude all data points. 
80% = has a +/- 20° tolerance 
70% = has a +/- 30° tolerance 
60% = has a +/- 40° tolerance 
50% = has a +/- 50° tolerance 
25% = has a +/- 90° tolerance 
0%  = allows all data points to pass through. 
 

For most cases any data with a quality factor less than 50% should be 
discarded. 
 
 

c. Time Varying Gain (TVG): This option allows the user to apply TVG in dB 
per 100m to the bathymetry solutions.  EdgeTech has incorporated this 
feature to increase the bathymetry range in soft bottom conditions. 
 

This parameter can have one of three options as described below. 

i. Default:  this option adjusts the TVG according to the operating 
frequency and requires no input from the user. 

ii. Display:  this option applies the TVG set in the display settings as 
shown in Figure 42.  This option requires constant monitoring of 
the side scan imagery and the TVG must be normalized as the 
composition of the seafloor changes.  This can be done by clicking 
on the T button, or it can be manually adjusted by using the + or – 
buttons (see Figure 42). 
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Figure 42:  Discover Toolbar Menu 

iii. Manual:  this option allows the user to input a manual TVG value.  
This number is specified in the box to the right of the drop down 
menu.  When this option is selected, the user can also specify a 
maximum TVG value in the Max TVG (dB) field (see Figure 43).  
This option also requires constant monitoring of the side scan 
imagery so that the correct TVG value is applied to the bathymetric 
solutions. 

 

Figure 43:  Inputting a Manual TVG 

Note:  If TVG mode is activated, then the Echo Strength Filter in the 
Basic Bathymetry Parameters can be increased to reduce noise at the 
extremities of the bathymetry solutions.  Monitoring the results in the 
Interferometry window will help the user determine what TVG value is 
best for the current conditions.  (The Interferometry window is explained 
in the following section.) 

Once these parameters under the Advanced Controls have been set do not 
change them during a survey.  This will require you to perform another 
calibration patch test, so it is very important to set these parameters correctly.   
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Interferometry 

DISCOVER now offers an interferometry display.  This window displays the raw 
interferometry points before binning and averaging, and is not corrected for motion.  
This display can be accessed by selecting Bathymetry from the Top Menu and then 
Interferometry Display as in Figure 44 and Figure 45.  
 

 

Figure 44: Activating the Interferometry Display 

 

 

Figure 45: Interferometry Display 

The Interferometry Display allows the user to see the effects of the various filters 
built in to DISCOVER.  The built in filters are listed below and each have a 
designated color associated with it. 

i. Echo Strength Filter (red) 
ii. Quality Filter (orange) 
iii. SNR Filter (yellow) 
iv. Water Column Filter (blue) 
v. Outlier Filter (purple) 
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The BATHYMETRIC PROCESSOR also offers a Data Filtering Dialog.  To access it, 
simply click on Bathymetry, and then Filtering as shown in Figure 46. 

 

Figure 46: Accessing the Filtering Options 

 

Figure 47: Filtering Options 

Each filter has a designated color for easier viewing within the Interferometry 
window.  To view the different filters, the user must first uncheck the Trim Flagged 
Points in Bathymetric Processor in Figure 47, then select VIEW from the top of the 
Interferometry screen (Figure 48), and then select a desired filter.   The green 
points, known as Unfiltered Points, display the data that has passed all filters and is 
designated as valid data. 

 

Figure 48:  Viewing the Filters in the Interferometry Window 
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As a reminder, the Echo Strength and SNR filters are controlled in the Basic 
Processing Parameters window, while the Quality filter is within the Advanced 
Controls.  The Water Colum and Outlier Filter are always enabled. 

 

 

Figure 49: Basic Bathymetric Controls 

 

 

Figure 50: Advanced Bathymetric Controls 
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If the user would like to allow certain points to pass through the Discover output and 
handed off to the third party topside software, all the user has to do is uncheck the 
corresponding filter box in Figure 47.   

The filtering parameters are repeated in the Bathymetric Data Filtering window for easier 
access between the dialogs.  If a value is changed in the Basic Bathymetry Controls (Figure 
49), the change is reflected in the Filtering window (Figure 47), and vice versa. 
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5.2.2  Engineering Displays 

DISCOVER and the BATHYMETRIC PROCESSOR offer a few more features for 
troubleshooting and training purposes.  These engineering displays are described 
below and are usually not displayed during normal surveying conditions. 

 

Connection Status 

In the DISCOVER main window (Figure 20), locate View from the Top Menu and 
select Connection Information.  Here you will find the Sonar Control and Sonar 
Data connections status window (Figure 51).  This window displays the connection 
status between the DISCOVER 4600 and the installed External Topside 
Interface.  To turn off this window, simply click Done. 
 

 

Figure 51:  Connection Information 

 
If any Disconnections are witnessed under any one of these two sections, please 
check to see if the correct password was installed.  For help in doing so, please 
contact Customer Service. 
 
You can also check the connection status between the BATHYMETRIC PROCESSOR 
and DISCOVER 4600.  This can be done by selecting View > Connection Status 
from the BATHYMETRIC PROCESSOR’s Top Menu (Figure 52). 
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Figure 52:  Bathymetric Processor 

The following window should appear: 

 

Figure 53:  Connection Status Window 

Here you will find the Sonar Control, Sonar Data In, and Sonar Data Out connections 
status window (Figure 53).  To turn off this window, simply click on View from the 
Top Menu (Figure 52) and uncheck the Connection Status window.  If any 
Disconnections are witnessed under any one of these three sections, please turn all 
systems off and reboot.  If the problem persists, please contact Customer Service. 
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Situation Status 
 

From the Top Menu of the Main DISCOVER window, under View > Situation Status 
you will find the number of incoming processed messages from each connected serial 
port (Figure 54).  To turn off this window, simply navigate to View > Situation Status 
and uncheck it. 

 

Figure 54:  Situation Status 

 

Here you can assign a specific COM port for each message, or set the field to ANY 
and the Bathymetric Processor will automatically find the message on which it is 
being parsed.  Also there is the option to turn OFF the message.   

If any checked NMEA messages are showing zero, please check the power on the 
device that is outputting those strings.  This same procedure is followed if the 
pitch/roll processed value is also showing 0.  If the problem persists, please 
contact Customer Service. 
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Processing Parameters 

Under View > Engineering Displays > Processing Parameters you will find 
important information about the 4600 system (Figure 55).  Some fields include the 
array installation angles (in degrees) and element spacing (in meters), multipath 
suppression level, altitude determination source (also known as Bottom Track Data 
Source), etc.  To turn off this window, simply navigate to View > Engineering 
Displays > Processing Parameters. 
 

 

Figure 55:  Processing Parameters 
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Processing Details 
 

Under View > Engineering Displays > Processing Details you will find the 
processing details (Figure 56).  Some fields include the number of processed and 
partial pings, detected altitudes, last altitude detected (in meters), and percent 
queues.  Some of these details have been repeated in the BATHYMETRIC 

PROCESSOR Main Window (Figure 20, right).  To turn off this window, simply 
navigate to View > Engineering Displays > Processing Details. 

 

 

Figure 56:  Processing Details  
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5.3 Third Party Software 
Currently, HYPACK is the only software that has been approved by EdgeTech, but work 
continues to expand the number of available topsides.  A brief description is listed in 
below. 

 

5.3.1 HYPACK 
 

The processed bathymetry and side scan data is sent in real-time to the 
HYPACK®/HYSWEEP® survey applications.  These application display and record the 
bathymetric data in HYPACK’s HSX format.  These HSX files can then be used off 
line in the MBMax, Side Scan Mosaic, and other proprietary packages that support 
these formats, to edit, clean, and mosaic the collected data. 
 
A complete guide on how to use HYPACK with the EdgeTech 4600 system is given 
in the HYPACK Software Guide for the EdgeTech 4600 System. 
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6. Frequently Asked Questions? 

This section provides a list of frequently asked questions pertaining to the EdgeTech 
4600 Swath Bathymetry and Side Scan System.   
 
 

[1] Which frequency is better?  The 230 kHz or the 540 kHz? 

Both systems work very well but each has its own benefits depending on the 
environment, water depth, and application.  For customers who mainly operate in 
open ocean environments with a depth of 30 to 100 meters of water, the 230 kHz 
system is the optimal solution.  For customer’s surveying mostly in channels, 
creeks, and other enclosed bodies of water and operating in depths of about 2 to 
30 meters, the 540 kHz system is the best fit.  Please contact Customer Service 
for more information on the benefits of each system. 

 

[2] Does the 4600 system interface to Ethernet devices? 

Currently the 4600 system can only interface to supporting sensors via the three 
COM ports (RS-232) in the back of the Topside Interface Box.  Please check with 
EdgeTech as it is an upcoming feature. 

 

[3] Where is the best place to mount the 4600 Sonar Head on the survey vessel? 

The bow of a survey vessel is always the best place to mount the 4600 Sonar 
Head.  By placing the system at the bow, the sonar will most likely be far enough 
away from most interferences such as hull echo(es), propeller noise, wake, etc. 

  

[4] How long can I keep my 4600 Sonar Head in the water for? 

The 4600 system was not designed with a permanent submerged installation in 
mind.  It is recommended that the 4600 system remain submerged no longer 
than 2 weeks at a time, especially in warm salty waters.  Fouling and corrosion 
may degrade the measurements of the 4600 system and/or the sound velocity 
sensor in the nose of the Sonar Head.  It is recommended that the arrays’ faces 
be checked regularly, and if fouling is observed, to please clean them using a 
wash cloth with mild soap and fresh water.  It is also recommended that the SVS 
in the nose is regularly inspected and cleaned, as well as calibrated once every 
two years.   
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[5] How often should I rinse my system? 

Please rinse the 4600 Sonar Head after every mission.  Please pay special 
attention to the SVS in the nose and the connectors in the tail, rinsing them 
thoroughly using the rinse holes provided.  Also, it is a good idea to rinse the 
deck cable and flush its track using the keyway at the top of the mounting 
bracket. 

 

[6] What if the Topside Processor or Topside Interface does not turn on? 

If the Topside Processor or Topside Interface does not turn on, please check the 
on/off switch in the back of the 19” mountable rack.  Both are located next to the 
power plug of their respective box. 

 

[7] Do I always need a sound velocity cast? 

It is always a good idea to collect a sound velocity profile, especially in the area 
where you collected your patch test data.  Most likely the water you are 
operating in does not have a uniform sound velocity, and depending on how 
drastic the profile is, a depth error as large as 1.6 m has been witnessed! 

 

[8] Can I incorporate RTK Tide measurements with the 4600 system? 

Yes.  HYPACK has the ability to set up a mobile device under Hypack Hardware 
that has been made especially for this.  Please see the Tide Support Section on 
page 26 of the HYPACK Software Guide for the EdgeTech 4600 System for 
more details. 

 

[9] Why can’t I feed navigation directly into the Topside Computer? 

In order for the 4600 to properly process the bathymetry data, it needs all of the 
supporting information, such as position, heading, roll, pitch, and heave.  By 
inputting the supporting device directly into the computer poses a risk of 
mismatching time stamps.  If the time stamps do not match, the bathymetric 
processor will not know which ping to coordinate the data with.     

 

[10] How often should I connect to the Remote Desktop Connection (Sonar.exe) and 
check to see the status of the supporting data? 

You should only need to do this if a device is not connected properly.  Usually this 
is done during training with an experienced representative from EdgeTech.  It is 
not recommended for users to connect to the sonar without EdgeTech support. 
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[11] What do I do if I do not see data scrolling in DISCOVER? 

Check to see if the Sonar Head has connected to DISCOVER by checking the 
status of the network (NET: ON) down in the right hand corner of the DISCOVER 
main window (please see Section 5.2 of this manual).  It usually takes about a 
minute and a half for the Sonar Head to boot and connect to the Topside 
Processor.  If the problem persists, please contact Customer Service using the 
information provided on page x of this manual.   

 

[12] What do I do if the Diagnostic window will not disappear, even after I’ve clicked 
Done? 

If DISCOVER is connected, check the Diagnostic window for any missing data on 
any of the three/four COM ports (depending on how your system has been 
configured).  If one Port is showing “Port Inactive” check the connection of the 
device and the Topside Interface Box.  If a Port is showing “Unknown Data”, 
check the format of the devices output data.  Ensure the data format follows 
Section 3.1 of this manual).  If the problem persists, please contact Customer 
Service using the information provided on page x of this manual.   

 

[13] Can the 4600 System measure pilings or vertical objects? 

The 4600 system can measure vertical objects, if configured to do so.  Currently, 
the system acquires data that is then binned and averaged according to a 
specified number of horizontal bins.  In doing so, the system can only measure 
horizontal features and so it should not be relied upon to measure vertical 
objects. 

 

[14] If I am constantly surveying within a channel, should I adjust the Multipath 
Suppression Level? 

If you are consistently surveying within a channel, the Multipath Suppression 
Level can be adjusted to 1.  This will give you more soundings along the bank of 
the channel but it will decrease the number of soundings measured at Nadir. 

 

[15] Why do I have to redo my patch test after changing the Multipath Suppression 
Level and/or Maximum Across Track Average Size (m)? 

The Multipath Suppression Level and the Maximum Across Track Average 
Size are parameters used by the BATHYMETRIC PROCESSOR to estimate the 
depths of the seafloor.  Changing these parameters alters the way the soundings 
and installation offsets are computed, so it is very important to re-acquire the 
Patch Test data once these limits have been modified. 
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[16] What is the difference between the options listed under Bottom Track Data 
Source (Port, Starboard, Sum, or Product)? 

The Bottom Track Data Source parameter states how the BATHYMETRIC 
PROCESSOR should calculate the depth of the seafloor.   These options include 
using the port side array only, starboard side array only, sum the two arrays on 
each side, or take the product of both arrays.  A more detailed explanation is 
provided in Section 5.2.1 of this manual.    

 

[17] What do I do if I do not see data scrolling in my Third Party Software? 

Check to see if DISCOVER is connected to your Third Party Software following the 
directions stated in Section 5.2.2. 
 

 
[18] The 4600 system connects with Hypack and Triton, why doesn’t connect with 

other topsides? 

EdgeTech has approved a small number of Third Party Topsides for acquisition 
and processing of the bathymetry and side scan data.  Currently, only HYPACK 
and TRITON IMAGING software have been approved, but work continues to 
expand the number of topsides.  Please contact EdgeTech for updates. 

 

[19] What should I do if my Topside crashes? 

Please contact EdgeTech Customer Service immediately so we can help 
restore your system and get you back up and running as soon as possible. 
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Configuring the COM Ports 

There are 3 available COM ports on the Interface Box to provide the necessary information 
to the 4600. This information includes position (latitude/longitude), heading, attitude (roll, 
pitch, and heave), and time.  This section explains how to configure the three COM ports 
depending on what type of sensors are used.  

A.1 One Sensor 

One sensor, such as the Applanix PosMV, may be used to supply position 
(latitude/longitude), heading, attitude, and a time source.  For this type of configuration, 
only COM1 will be utilized.   

To configure the COM ports for one sensor, the following steps should be carried out. 

1. Turn on the 4600 Topside Processor and connect the 4600 via the deck cable to the 
Topside Interface Box.   

2. Turn on the 4600 Sonar Head and run the Remote Desktop Application, named 
Sonar.  The main screen as in Fig.  1 should appear. 

Here, you will see the Sonar Application running (designated by the blue arrow).  
This is the firmware that controls the system. 

3. Click on the ‘X’ at the top right to close the firmware. 

4. Now, double click on the Shortcut to EdgeTech icon (red arrow, Fig.  2) and open the 
SSSonar folder, then the Sonar folder. 

5. Look for the SonarSerial.ini file (Fig.  3) and open it using WordPad or Notepad (Fig.  
4). 

6. Under [Serial2] and [Serial3] set Create = 0, select File > Save, and close the file.  
DO NOT TOUCH ANYTHING ELSE!!  This will deactivate COM ports 2 and 3. By 
deactivating these ports, Sonar will report to Discover that only one sensor is to be 
used on COM1 to parse the necessary sensor information.  Therefore, Discover will 
not throw up any errors if a sensor is not connected to COM2 or COM3. 

If steps 3 through 6 were not carried out, then these errors would be reported in the 
Diagnostic window (Fig.  5). 

7. Close the SonarSerial.ini file and reboot the Sonar Firmware by double clicking on 
the Sonar icon in the main Sonar Remote Desktop Screen (designated by the green 
arrow in Fig.  6). 

Proceed to Step 8 on page A5. 
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Fig.  1 – Sonar Remote Desktop Application, Main Screen 

 

Fig.  2 - Sonar Remote Desktop, Shortcut to EdgeTech folder 
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Fig.  3 - Finding the SonarSerial.ini file 
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Fig.  4 - SonarSerial.ini File 

 

 

Fig.  5 - Diagnostic Window, Reporting Ports Inactive Error 
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Fig.  6 - Rebooting Sonar from the main screen 

8. Now, plug in your device into COM 1. 

9. Click on the Misc. at the top of the Sonar screen (as shown in Fig.  7), then Serial 
Port Information… 

10. Check COM1 and set the correct baud rate for that device by using the drop down 
menu shown in blue (Fig.  7). When the correct baud rate is set, the State should 
say OK and Errors should not be increasing (as circled in green, Fig.  7). The correct 
data string should also be scrolling in the lower part of the window (green arrow, Fig.  
7). 

11. Now click on File > Show Status in the sonar window (circled in red, Fig.  8). 

12. On the right hand side of the window, click on the Config bullet under the Update 
button and then on the drop down menu named Config Item (in green). 

13. Select Serial and then click on the Update button several times (blue arrow). 

14. Check to make sure the sensor’s usage percentage is well below 80% (circled in 
purple).  If it is not, increase the baud rate of the sensor, change the baud rate 
under Serial Port Information as done before in step 10, and check the Status again, 
otherwise the sonar will report errors. Proceed to step 15 on page A7. 
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Fig.  7 - Checking Serial Port Information 

 

Fig.  8 – Checking Sensor Status 
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15.  When satisfied with the incoming data, press OK in the System Status window (Fig.  
9). 

 

Fig.  9 - Closing the System Status Window 

16. Finally, close the Sonar – 192.9.0.101 – Remote Desktop Connection window.   

If this window is left open during data acquisition, the user may experience a very 
slow computer.  This is because the remote desktop application uses a large amount 
of the link capacity to stay open. So it is always a good idea to close the remote 
desktop application when finished with the configurations. 
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A.2 Two Sensors 

Two sensors, such as a dual headed GPS (heading, position, and time source) and a Motion 
Reference Unit (roll, pitch, and heave) may be used to supply the necessary information.  
For this type of configuration, only COM1 and COM2 will be utilized.   

To configure the COM ports for the two sensors, the following steps should be carried out. 

1. Follow steps (1.) through (6.) as stated previously under Section A.1.   

2. Under [Serial3] set Create = 0, select File > Save, and close the file (Fig.  10).  DO 
NOT TOUCH ANYTHING ELSE! 

 

Fig.  10 - SonarSerial.ini File 

This will deactivate COM3. By deactivating this port, Sonar will report to Discover 
that only two sensors are to be used on COM1 and COM 2 to parse the necessary 
sensor information.  Therefore, Discover will not throw up any errors if a sensor is 
not connected to COM3. 
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3. Close the SonarSerial.ini file and reboot the Sonar Firmware by double clicking on 
the Sonar icon in the main Sonar Remote Desktop Screen (designated by the green 
arrow in Fig.  6, pg A5). 

4. Now, plug in your devices into COM 1 and COM 2.  Which device is connected to 
which COM port does not matter, as long as their respective ports and baud rates are 
noted. 

5. Click on the Misc. at the top of the Sonar screen (as shown in Fig.  7, pg A6), then 
Serial Port Information… 

6. Check COM1 and set the correct baud rate for that device by using the drop down 
menu shown in blue (Fig.  7, pg A6). When the correct baud rate is set, the State 
should say OK and Errors should not be increasing (as circled in green, Fig.  7, A6). 
The correct data string should also be scrolling in the lower part of the window 
(green arrow, Fig.  7, A6). 

7. Now Check COM2 and set the correct baud rate for the other device as done before 
in Step 6. 

8. Now click on File > Show Status in the sonar window (circled in red, Fig.  8, pg 
A6). 

9. On the right hand side of the window, click on the Config bullet under the Update 
button and then on the drop down menu named Config Item (in green, Fig.  8, pg 
A6). 

10. Select Serial and then click on the Update button several times (blue arrow, Fig.  8, 
pg A6). 

11. Check to make sure the sensors’ usage percentages are well below 80% (circled in 
purple, Fig.  8, pg A10).  If they are not, increase the baud rate of the sensor, 
change the baud rate under Serial Port Information as done before in steps 6 and 
7, and check the Status again, otherwise the sonar will report errors. 
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Fig.  11 - Checking Sensors' Usages 

12. When satisfied with the incoming data, press OK in the System Status window (Fig.  
11). 

13. Finally, close the Sonar – 192.9.0.101 – Remote Desktop Connection window.   

If this window is left open during data acquisition, the user may experience a very 
slow computer.  This is because the remote desktop application uses a large amount 
of the link capacity to stay open. So it is always a good idea to close the remote 
desktop application when finished with the configurations. 
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A.3 Three Sensors 

Three sensors, such as a gyro (heading), a GPS (position, and time source) and a Motion 
Reference Unit (roll, pitch, and heave) may be used to supply the necessary information.  
For this type of configuration, all available COM ports will be utilized.   

To configure the COM ports for the three sensors, the following steps should be carried out. 

1. Follow steps (1.) through (6.) as stated previously under Section A.1.   

2. Make sure Create under each [Serial#] description is set to 1 (Create = 1). (Fig.  
12) 

 

Fig.  12 - All Sensors Set 

3. Then select File > Save, and close the file.  DO NOT TOUCH ANYTHING ELSE! 

4. Close the SonarSerial.ini file and reboot the Sonar Firmware by double clicking on 
the Sonar icon in the main Sonar Remote Desktop Screen (designated by the green 
arrow in Fig.  6, pg A5). 



        
 
 

 
4600 REFERENCE MANUAL A12 OF A13 REV G 
 

4600 Swath Bathymetry  
and Side-Scan Sonar 

5. Now, plug in your devices into COM 1, COM 2, and COM 3.  The Gyro should be 
connected to COM1, the MRU COM2, and the GPS to COM3.  The devices connected 
to COM1 or COM2 may be interchanged but the GPS must be connected to COM3.   

6. Click on the Misc. at the top of the Sonar screen (as shown in Fig.  7, pg A6), then 
Serial Port Information… 

7. Check COM1 and set the correct baud rate for that device by using the drop down 
menu shown in blue (Fig.  7, pg A6). When the correct baud rate is set, the State 
should say OK and Errors should not be increasing (as circled in green, Fig.  7, A6). 
The correct data string should also be scrolling in the lower part of the window 
(green arrow, Fig.  7, A6). 

8. Now check COM2 and set the correct baud rate for the other device as done before in 
Step 6. 

9. Also, remember to check COM3 as before and set the correct baud rate for GPS. 

10. Now click on File > Show Status in the sonar window (circled in red, Fig.  8, pg 
A6). 

11. On the right hand side of the window, click on the Config bullet under the Update 
button and then on the drop down menu named Config Item (in green, Fig.  8, pg 
A6). 

12. Select Serial and then click on the Update button several times (blue arrow, Fig. 
13, A13). 

13. Check to make sure the sensors’ usage percentages are well below 80% (circled in 
purple, Fig. 13, pg A13).  If they are not, increase the baud rate of the sensor, 
change the baud rate under Serial Port Information as done before in steps 6 and 7, 
and check the Status again, otherwise the sonar will report errors. 

14. When satisfied with the incoming data, press OK in the System Status window (Fig. 
13, pg A13). 

15. Finally, close the Sonar – 192.9.0.101 – Remote Desktop Connection window.   
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If this window is left open during data acquisition, the user may experience a very 
slow computer.  This is because the remote desktop application uses a large amount 
of the link capacity to stay open. So it is always a good idea to close the remote 
desktop application when finished with the configurations. 

 

 

Fig. 13 - Checking all COM Ports 
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Performing a Rub Test 
 

This test is carried out on a bench or work table and is usually used to indicate if the receive 
section of the Sonar Arrays is working properly.  This section states how a Rub Test should 
be performed. 

Note 1:  If the Rub Test fails, please contact EdgeTech immediately using the provided 
information in the Customer Service Section on page x of this manual. 

Note 2:  In this section, it is assumed that the 4600 Topside Processor, monitors, 
keyboard, and mouse are all connected and powered on.  If this has not been done yet, 
please do so at this moment. 

1. Ensure the Ethernet from Port1 of the 4600 Topside Interface is plugged into the 
Ethernet Port1 of the Topside Processor (labeled SONAR). 
 

2. Turn the Sonar Head ON by using the switch on the front side of the 4600 Sonar 
Interface. 

Note:  If the Topside Interface does not turn ON, check to see if the switch next to 
the power cable (on the back of the Topside Unit) is in the ON position.  If not, flip 
the switch to the ON position. 

3. Wait several minutes.  This waiting period allows the Sonar Head’s Processing Unit to 
connect with the Topside Processor. 
 

4. Launch JSTAR using the shortcut on the Desktop, or alternatively, navigate to 
C:\EdgeTech\JSTAR4600 and launch the JSTAR Application.  The main window will 
appear with 8 cells (Fig.  14). These cells correspond to each coupled port and 
starboard channels. 
 
Note:  If the window that appears does not resemble Fig.  14, please load the 
configuration file by File > Load Configuration > JStar_4600_Rub Test.jni. 
 

5. Ensure the Sonar Head is connected to JSTAR by checking that the network is on 
(NET: ON) in the bottom right hand corner of the window. 
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Fig.  14 - JSTAR Startup Window 

 

6. Click on the    icon to open up the Status and Control Window (Fig.  15). 
 

7. Select the 4600 tab and check the Ping On box under the Transmit section.  This 
will engage the 4600 Sonar Head to start receiving signals. 
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Fig.  15 -  JSTAR Status and Control Window 

 

8. Rub your hand vigorously across the face of the Port Array for 3 seconds and 
observe the response in JSTAR. 

 

 

Fig.  16 -  Array – Rub Test 

 
9. Repeat the Rub Test for the Starboard Array.  If the response in JSTAR resembles 

Fig.  17, then the Arrays have passed.  If any channels do not respond (as in the 
example illustrated in Fig.  18), please contact EdgeTech using the information 
provided in the Customer Service Section on page x. 
 

10. Exit out of JSTAR when finished, as this will cause a network conflict between JSTAR 
and DISCOVER if both programs are trying to run at the same time. 

 
 
 
 



        
 
 

4600 REFERENCE MANUAL B4 OF B5 REV G 
 

4600 Swath Bathymetry  
and Side-Scan Sonar 

Note 1:  Each cell is split in half by a yellow line.  Above this yellow line corresponds to 
the Port side channels and below this line corresponds to the Starboard channels. 
 
Note 2:  Each cell also represents the different elements for each array (see Fig.  17 
and Fig.  18 for element assignment.) 

 

 

 

 

Fig.  17 - Rub Test for 4600 Port and Starboard Arrays (PASSED) 
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Note 1:  Each cell is split in half by a yellow line.  Above this yellow line corresponds to 
the Port side channels and below this line corresponds to the Starboard channels. 
 
Note 2:  Each cell also represents the different elements for each array (see Fig.  17 
and Fig.  18 for element assignment.) 

 

 

 

 

Fig.  18 - Rub Test for 4600 Port and Starboard Arrays (FAILED)
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Hardware Data Flow Diagram 
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Sonar Interface Box Connections 
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Bow Mount Example 
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Side Mount Example 
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Terminated Deck Cable Wiring Diagram 
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Non-Terminated Deck Cable Wiring Diagram 
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Acoustic Centers (Standard Body Type) 
 

 


